
Installation Help
    

Installation Options:
The following installation options are supported:

· View Tech Info File - Use this button to view the technical notes.    You must view these notes before 
continuing with the rest of the installation.

· View License Information - Use this button to view the terms upon which this program can be used.    
You must review and agree to these terms before installing the program.

· Start Install - Use this button to start the installation process.    Make sure you have selected the 
desired installation and directory options before starting the installation process.

· Cancel Install - Use this button to cancel the installation process.    You can restart it at any time.

· Install Programs - Check this option to copy the program and help files to your hard disk.

· Install Demo Files - Check this option to copy the demonstration files to your hard disk.    This option 
is highly recommended.    See the "Deleting the Demonstration Files" section, later in this file, for 
information on deleting these files to start fresh with your own data. 
          

· Build Program Group - Check this option to build a Windows program group for this program.    This 
option supports the Windows Program Manager only, if you are using another Windows shell, like the 
Norton Desktop, do not use this option.    Instead, setup your shell to execute MAPMAIN.EXE. 

· From Directory Name - Enter the drive and path where the installation files can be found.    The format
entered must be "drive:\path" or an error message will be displayed.

· To Directory Name - Enter the hard drive and path where you want the program installed.    The format
entered must be "drive:\path" or an error message will be displayed.







Welcome to The Bill Drawer! 

This program is designed to help you pay your bills in a timely manner.    Unlike "checkbook" programs, 
which assume you know what you want to pay, "The Bill Drawer" helps you organize your bills by their 
due date, then gives you powerful features to review, select and write checks for only the bills you desire.  
In addition, there are many features to help you control and analyze your unpaid bills and expenditures 
like:

· Recurring bills    
· Disputed bills
· Late or discounted payment amounts
· Cash requirements reporting 
· Multiple expense categories per bill
· Monthly and yearly statistics for companies and categories
· Full check register and supporting detail
· Support for multiple bank accounts
· Support for multiple preprinted check formats
· Payment history reporting by company or category
· 941 tax reporting    

Furthermore, The Bill Drawer contains many features to help you control and reconcile your bank 
accounts like:

· Full check register with supporting detail
· Manual check, deposit and withdrawal entry
· Control of last check number used
· Multiple expense categories per check or withdrawal
· Multiple income categories per deposit
· Support for voided checks and corrections
· Monthly and yearly statistics for each bank account
· Full account reconciliation functions to help balance your statements
· Tax deductable payment tracking 

Finally, recognizing that these are your important financial records, The Bill Drawer contains a complete 
security system keyed by user name and password.    You can fully control who can access any program 
function, and whether they can merely look at or update the information presented by that function.    

Introduction:
To help you get full use out of The Bill Drawer, and to help you configure the program to operate in a wide 
variety of environments, the following technical information is presented:    

· Program Requirements - This section details Windows and MS-DOS requirements you must follow.    
Be sure to read this section.

· Installation Options - This section explains the various installation options available with The Bill 



Drawer Installation program. 

· New Features - This section lists the major new features available with version 2.10 of The Bill 
Drawer.    This will be of special interest to users of previous versions of this program.

· Registration Features - This section describes what you get if you decide to register the program.    
This section will be of    interest    to all users.

· Configuring the Program - This section explains various advanced program options.    Be sure to read 
this section if if you move the program files to a different directory than the one you originally installed 
to. 

· Deleting the Demonstration Files - This section explains how to delete the demonstration files that are
installed to help you get started.    Read this section when you want to get started entering your own 
data. 

Note: We suggest that you print these notes using the Print Topic function, located under the File 
menu.    

Program Requirements:
Please read the following requirements carefully, they must be followed for the program to correctly 
operate:

· Microsoft Windows - The Bill Drawer is a Microsoft    Windows program, and as such requires 
Windows version 3.1 or higher.    The program has been optimized especially for Windows version 3.1
and will not function with Windows 3.0.    
                

· MS-DOS    version 3.3 or higher is required.    

· A minimum of 3 megabytes of hard disk space is required to install and operate the program.    

· SHARE.EXE - The Bill Drawer requires SHARE for both program installation and normal operation.    
SHARE is a MS-DOS command that helps protect the data files from damage if multiple users or 
applications access the files simultaneously.    To load SHARE, simply type "SHARE" from the MS-
DOS command line before starting Windows.    You can also place the command in your 
AUTOEXEC.BAT file.    

Caution:    If you do not have SHARE loaded now, you must do so before continuing the 
installation.    

Installation Options:
The following installation options are supported:

· View Tech Info File - Use this button to view the technical notes.    You must view these notes before 
continuing with the rest of the installation.

· View License Information - Use this button to view the terms upon which this program can be used.    
You must review and agree to these terms before installing the program.

· Start Install - Use this button to start the installation process.    Make sure you have selected the 



desired installation and directory options before starting the installation process.

· Cancel Install - Use this button to cancel the installation process.    You can restart it at any time.

· Install Programs - Check this option to copy the program and help files to your hard disk.

· Install Demo Files - Check this option to copy the demonstration files to your hard disk.    This option 
is highly recommended.    See the "Deleting the Demonstration Files" section, later in this file, for 
information on deleting these files to start fresh with your own data. 
          

· Build Program Group - Check this option to build a Windows program group for this program.    This 
option supports the Windows Program Manager only, if you are using another Windows shell, like the 
Norton Desktop, do not use this option.    Instead, setup your shell to execute MAPMAIN.EXE. 

· From Directory Name - Enter the drive and path where the installation files can be found.    The format
entered must be "drive:\path" or an error message will be displayed.

· To Directory Name - Enter the hard drive and path where you want the program installed.    The format
entered must be "drive:\path" or an error message will be displayed.

New Features:
Version 2.10 of this program has the following major new features:

· Multiple (split) categories per bill, check, withdrawal or deposit.

· Categories can now be summarized for improved reporting.    The category summary level controls 
which categories will be summarized together. 

· The category, company and bank account statistics have been improved and now include both 
monthly and yearly statistics.

· Disputed bills are fully supported.    You can dispute any portion of a bill and withhold it from payment. 

· Full bank account reconciliation has been added.    In addition, you can perform any required 
adjustments from within the reconciliation process.    Bank account statistics include last statement 
information.

· Overdrawing checking accounts is now supported, up to a predefined limit you set.

· A complete user security system has been added to protect the confidentiality of your financial data.    
You can limit functions within the program, like paying bills, to specific users.    

· A new reporting engine has been added to allow much greater flexibility in reports.    For example, all 
reports can now be viewed in a window and then optionally printed. 

Registration Features:
In addition to a clear conscious, registration includes the following:



· The current commercial version of the program and notification of new program versions.

· The Bill Drawer User Guide, a printed manual containing over 130 pages of information.    It includes 
information on ordering checks and sample check forms.

· The reporting engine and associated standard reports.    Over fifteen different reports are provided to 
help you get more value out of The Bill Drawer.    The reporting engine let's you review these reports 
in a scrollable, re-sizable window, or print them to any Windows supported printer.      

· Paradox format files.    The commercial version of The Bill Drawer uses Paradox format files.    The 
Paradox file format is the native format of Borland's Paradox database system and is supported by 
many different software products.    Since The Bill Drawer adheres to this file format for all it's major 
files, you can use these products to build additional windows, reports or functions specific to your own
requirements.    For example, you could use Borland's Quattro Pro spreadsheet to import bank 
account, category or company statistics and further summarize or graph them.        

Note: The commercial version includes a procedure to convert your existing shareware Bill Drawer 
files to the Paradox format. 
        

· Per the license agreement, you may use this program for 30 days to evaluate it's suitability to your 
needs.    At the end of    this period you must either register it or delete it from all computer systems 
where it was installed.      The registration fee is a very reasonable $30 (US) payable to:

MelissaSoft Systems
11676 Windcrest Lane
San Diego, CA 92128

Please use the "REGISTER.TXT" form when registering, you can print it with Windows Notepad 
(under the Accessories group).      We have many exciting plans for future versions of this program, 
but they will not happen without enough people telling us they like the program by registering it.    

Configuring the Program:
The MAP0200.INI file, located in the directory you installed the program to, contains several options you 
might want to change.    Use the Windows Notepad, located in the Accessories Group, to change options 
in this file.    Note that the file is in standard Windows INI file format. 

The following options can be changed:
· FileDir=C:\MELSOFT\BILLS\DATA - This is the drive and path where your data files are located.    Do 

not change this option unless you want to create new data files, or move the existing files to the new 
directory.    The data files are all the files with "0200" in the file name and an extension of ".DAT"; like 
VEN0200.DAT, CAT0200.DAT and HST0200.DAT.    

· BackupDir=C:\MELSOFT\BILLS\BACKUP - This is the drive and path where your backup files will be 
created.    Change this option if you want to backup your files to a different location, perhaps another 
drive.    The backup files are all the files with "0200" in the file name and an extension of ".BAK"; like 
VEN0200.BAK, CAT0200.BAK and HST0200.BAK.    

· Password=560508 - Adding this option will activate the master password for the program.    Use this 
option when you have forgotten your password and need access to the program, or when you have 
deleted the security file    (SEC0200.DAT) and want to create it again.    When this option is present, 



you will not need to sign on to the program, but you will only have access to the User Security 
Information window.    Use this window to add new users, or change the password of an existing one 
to a known value.    Then exit    the program and remove this option so that the program functions 
normally.

The following options should not be changed, but are presented for completeness:

· ReportDir=C:\MELSOFT\BILLS - This is the drive and path where the program report files are located.
The shareware version of this program does not include the standard reports.

· MultiUser=0 - This option indicates whether multiple users will be accessing the program data files 
simultaneously. This value must be "0" for the shareware version.    It does not support multiple user 
access to the program data files.      
      

· Printer=HP DeskJet 500,HPDSKJET,LPT1: = This is the printer to be used for printing checks.    Do 
not change this option, instead use the Printer Setup menu option on the Print Checks window to 
control which printer is used for checks. 

· LastRoll=4 - This is the number of the month you have last rolled your statistics through.    It is used to
remind you when it's time to roll your statistics.    You should not change this option.

· CheckMaxDays=999 - This option controls the number of items displayed in the Check Register 
window.    It is used to generate the ending date to display items through.    Use the Set Maximum 
Days menu option on the Check Register window to set this value, rather than changing it here.

· SortYear=0 - This option controls the way dated items are presented on the Check Register window 
and other similar windows.    Use the Sort by Year menu option on the appropriate window to set this 
value, rather than changing it here.

Deleting the Demonstration Files:
After you have finished using the demonstration files to gain familiarity with the program, you will want to 
delete these files so that you can enter your own data.    Follow these steps to delete the demonstration 
files:

1. Using the Windows File Manager, delete the following data files in the data directory (usually C:\
MELSOFT\BILLS\DATA):
The bank account file - BNK0200.DAT.
The history file - HST0200.DAT.
The unpaid bill file - INV0200.DAT. 
The company file - VEN0200.DAT.

2. The check format file, FRM0200.DAT should be kept.    It contains definitions for the check forms 
described in The Bill Drawer User Guide which you will get when you register.    You can add your own
format definitions and delete any you do not want.

3. The report definition file, RPT0200.DAT must be kept.    It contains the definitions and security 
requirements for the standard reports.    You will be able to run these reports, after you register the 
program.    

4. The user security file, SEC0200.DAT must also be kept.    It contains definitions for all users who can 



use the program.    You can add your own users and delete any you do not want.
                  

5. The category file, CAT0200.DAT, can be kept or deleted depending on if you want to enter your own 
categories from scratch or modify the ones we gave you.    If you decide to modify the categories we 
supplied, you can clear the statistical totals using the "Roll Statistical Totals" menu option on the main 
The Bill Drawer window.    Select the "Category Totals" and the "Roll Yearly Totals" option.    Do this 
twice so both the this year and last year totals get cleared.      

6. Start the Bill Drawer again.    Note that you will get messages like "Bank account file not found in 
current directory - OK    to create new file?".    Respond "OK " and allow the program to create the new
files.    

7. Don't miss the Getting Started section in the main program help.    It contains a complete 
implementation plan to help you get started.    Just select "Help Index" from the Help menu on any 
window.    Then select "Getting Started" from the list of topics.          

Trademarks and Copyrights:
· The Bill Drawer is © Copyright 1993 MelissaSoft Systems.      All rights reserved.

· Microsoft, MS-DOS and Windows are either registered trademarks or trademarks of the Microsoft 
Corporation.

· Paradox    is a registered trademark of Borland International, Inc. 

· The Paradox Engine is © Copyright 1985, 1992 Borland International, Inc.

· All other brand or product names are either registered trademarks or trademarks of their respective 
holders.





Welcome to The Bill Drawer! 

This program is designed to help you pay your bills in a timely manner.    Unlike "checkbook" programs, 
which assume you know what you want to pay, "The Bill Drawer" helps you organize your bills by their 
due date, then gives you powerful features to review, select and write checks for only the bills you desire.  
In addition, there are many features to help you control and analyze your unpaid bills and expenditures 
like:

· Recurring bills    
· Disputed bills
· Late or discounted payment amounts
· Cash requirements reporting 
· Multiple expense categories per bill
· Monthly and yearly statistics for companies and categories
· Full check register and supporting detail
· Support for multiple bank accounts
· Support for multiple preprinted check formats
· Payment history reporting by company or category
· 941 tax reporting    

Furthermore, The Bill Drawer contains many features to help you control and reconcile your bank 
accounts like:

· Full check register with supporting detail
· Manual check, deposit and withdrawal entry
· Control of last check number used
· Multiple expense categories per check or withdrawal
· Multiple income categories per deposit
· Support for voided checks and corrections
· Monthly and yearly statistics for each bank account
· Full account reconciliation functions to help balance your statements
· Tax deductable payment tracking 

Finally, recognizing that these are your important financial records, The Bill Drawer contains a complete 
security system keyed by user name and password.    You can fully control who can access any program 
function, and whether they can merely look at or update the information presented by that function.    

Introduction:
To help you get full use out of The Bill Drawer, and to help you configure the program to operate in a wide 
variety of environments, the following technical information is presented:    

· Program Requirements - This section details Windows and MS-DOS requirements you must follow.    
Be sure to read this section.

· Installation Options - This section explains the various installation options available with The Bill 



Drawer Installation program. 

· New Features - This section lists the major new features available with version 2.10 of The Bill 
Drawer.    This will be of special interest to users of previous versions of this program.

· Paradox Format Files - This section describes what Paradox format files are and why they are used 
with The Bill Drawer.    This section will be of    interest    to all users.

· Configuring the Program - This section explains various advanced program options.    Be sure to read 
this section if you are going to install The Bill Drawer files on a LAN assessable drive, or if you are 
going to use another    product (like Paradox) to update The Bill Drawer data files.      

· Changing Paradox Versions - This section explains how you can reformat your data files to Paradox 
3.5 format, instead of the Paradox 4.0 format normally used.    Read this section if you have another 
product (like Microsoft Access) that can not access Paradox 4.0 format files, and you are going to use
this product to access The Bill Drawer data files.    

· Configuring the Paradox Engine - This section explains various advanced options for configuring the 
file driver used to maintain the Paradox format files.    Read this section if you have another product 
(like Borland Quattro Pro) that accesses Paradox files using the Paradox Engine, and you are going 
to use this product to access The Bill Drawer data files.    

· Deleting the Demonstration Files - This section explains how to delete the demonstration files that are
installed to help you get started.    Read this section when you want to get started entering your own 
data. 

· Converting Your Shareware Files - This section explains how to convert The Bill Drawer    version 2.10
shareware files to the commercial version.    Read this section if you have data you want to keep in 
your shareware version files.    

Note: We suggest that you print these notes using the Print Topic function, located under the File 
menu.    

Program Requirements:
Please read the following requirements carefully, they must be followed for the program to correctly 
operate:

· Microsoft Windows - The Bill Drawer is a Microsoft    Windows program, and as such requires 
Windows version 3.0 or higher.    Windows version 3.1 is highly recommended, as this is where the 
program has been the most thoroughly tested.    In addition, there are certain program features, like 
the "Printer Setup" menu option, that will not function in Windows version 3.0.    However, the lack of 
these features should not effect the overall operation of the program.
                

· MS-DOS    version 3.3 or higher is required.    

· A minimum of 4 megabytes of hard disk space is required to install and operate the program.    

· SHARE.EXE - The Bill Drawer requires SHARE for both program installation and normal operation.    
SHARE is a MS-DOS command that helps protect the data files from damage if multiple users or 
applications access the files simultaneously.    To load SHARE, simply type "SHARE" from the MS-
DOS command line before starting Windows.    You can also place the command in your 



AUTOEXEC.BAT file.    

Caution:    If you do not have SHARE loaded now, you must do so before continuing the 
installation.    

    
Installation Options:
The following installation options are supported:

· View Tech Info File - Use this button to view the technical notes.    You must view these notes before 
continuing with the rest of the installation.

· View License Information - Use this button to view the terms upon which this program can be used.    
You must review and agree to these terms before installing the program.

· Start Install - Use this button to start the installation process.    Make sure you have selected the 
desired installation and directory options before starting the installation process.

· Cancel Install - Use this button to cancel the installation process.    You can restart it at any time.

· Install Programs - Check this option to copy the program and help files to your hard disk.

· Install Demo Files - Check this option to copy the demonstration files to your hard disk.    This option 
is highly recommended.    See the "Deleting the Demonstration Files" section, later in this file, for 
information on deleting these files to start fresh with your own data. 
          

· Build Program Group - Check this option to build a Windows program group for this program.    This 
option supports the Windows Program Manager only, if you are using another Windows shell, like the 
Norton Desktop, do not use this option.    Instead, setup your shell to execute MAPMAIN.EXE. 

· From Directory Name - Enter the drive and path where the installation files can be found.    The format
entered must be "drive:\path" or an error message will be displayed.

· To Directory Name - Enter the hard drive and path where you want the program installed.    The format
entered must be "drive:\path" or an error message will be displayed.

New Features:
Version 2.10 of this program has the following major new features:

· Multiple (split) categories per bill, check, withdrawal or deposit.

· Categories can now be summarized for improved reporting.    The category summary level controls 
which categories will be summarized together. 

· The category, company and bank account statistics have been improved and now include both 
monthly and yearly statistics.

· Disputed bills are fully supported.    You can dispute any portion of a bill and withhold it from payment. 

· Full bank account reconciliation has been added.    In addition, you can perform any required 



adjustments from within the reconciliation process.    Bank account statistics include last statement 
information.

· Overdrawing checking accounts is now supported, up to a predefined limit you set.

· A complete user security system has been added to protect the confidentiality of your financial data.    
You can limit functions within the program, like paying bills, to specific users.    

· A new reporting engine has been added to allow much greater flexibility in reports.    For example, all 
reports can now be viewed in a window and then optionally printed. 

Paradox Format Files:
This commercial version of The Bill Drawer uses Paradox format files.    The Paradox file format is the 
native format of Borland's Paradox database system and is supported by many different software 
products.    Since The Bill Drawer adheres to this file format for all it's major files, you can use these 
products to build additional windows, reports or functions specific to your own requirements.    For 
example, you could use Borland's Quattro Pro spreadsheet to import bank account, category or company 
statistics and further summarize or graph them.    See Chapter 17 - Extending The Bill Drawer, in The Bill 
Drawer User Guide for more information on how you can extend the program for your own specific 
requirements.        

The Paradox Engine is the file driver that The Bill Drawer uses to create and maintain the Paradox format 
files.    It is not Paradox, but rather a Borland provided routine that knows this database format.    You 
should not assume The Bill Drawer is written in Paradox (or PAL).    It is not.    

Configuring the Program:
The MAP0200.INI file, located in the directory you installed the program to, contains several options you 
might want to change.    Use the Windows Notepad, located in the Accessories Group, to change options 
in this file.    Note that the file is in standard Windows INI file format. 

The following options can be changed:
· FileDir=C:\MELSOFT\BILLS\DATA - This is the drive and path where your data files are located.    Do 

not change this option unless you want to create new data files, or move the existing files to the new 
directory.    The data files are all the files with "0200" in the file name, like VEN0200.DB, CAT0200.X07
and HST0200.PX, except for the    files with a "BAK" extension.    These are the backup files.

· BackupDir=C:\MELSOFT\BILLS\BACKUP - This is the drive and path where your backup files will be 
created.    Change this option if you want to backup your files to a different location, perhaps another 
drive.    The backup files are all the files with "0200" in the file name and an extension of ".BAK"; like 
VEN0200.BAK, CAT0200.BAK and HST0200.BAK.    

· ReportDir=C:\MELSOFT\BILLS - This is the drive and path where the program report files are located.
Do not change this option unless you also move the existing report files to the new directory.    The 
report files are all the files with an extension of "RPT", like CATLIST1.RPT, HSTLIST3.RPT and 
VENSUM1.RPT.

· MultiUser=0 - This option indicates whether multiple users will be accessing the program data files 
simultaneously.    If you have placed the data files on a LAN assessable drive, or you plan on using a 
third party product, like Paradox, to update the Bill Drawer files, then you must turn this option on,    
"MultiUser=1", so that the program will appropriately lock records and protect them from damage.



· Password=560508 - Adding this option will activate the master password for the program.    Use this 
option when you have forgotten your password and need access to the program, or when you have 
deleted the security files (SEC0200.DB and    SEC0200.PX) and want to create them again.    When 
this option is present, you will not need to sign on to the program, but you will only have access to the
User Security Information window.    Use this window to add new users, or change the password of an
existing one to a known value.    Then exit    the program and remove this option so that the program 
functions normally.

The following options should not be changed, but are presented for completeness:
      

· Printer=HP DeskJet 500,HPDSKJET,LPT1: = This is the printer to be used for printing checks.    Do 
not change this option, instead use the Printer Setup menu option on the Print Checks window to 
control which printer is used for checks. 

· LastRoll=4 - This is the number of the month you have last rolled your statistics through.    It is used to
remind you when it's time to roll your statistics.    You should not change this option.

· CheckMaxDays=999 - This option controls the number of items displayed in the Check Register 
window.    It is used to generate the ending date to display items through.    Use the Set Maximum 
Days menu option on the Check Register window to set this value, rather than changing it here.

· SortYear=0 - This option controls the way dated items are presented on the Check Register window 
and other similar windows.    Use the Sort by Year menu option on the appropriate window to set this 
value, rather than changing it here.

    
Changing Paradox Versions: 
By default, the Bill Drawer installation program will install version 3.01 of the Paradox Engine.    This is a 
file driver that creates Paradox format files compatible with Paradox 4.0 for DOS and Paradox for 
Windows.    However, some products, like Microsoft Access, do not yet support the Paradox 4.0 format.    If
you want to use one of these products with The Bill Drawer, you can install version 2.0 of the Paradox 
Engine and recreate your data files in the older Paradox 3.5 format.        

To change to Paradox 3.5 format, follow these steps:
1. Start-up The Bill Drawer and backup all your data files using the Backup All Files menu option on the 

main window, or just allow the program to take a full backup upon exiting.

2. Using the Windows File    Manager, locate the file PXENGWIN.DLL in the main program directory, 
usually C:\MELSOFT\BILLS.    Note the time on this file is 03:01:00am, indicating version 3.01 of the 
Paradox Engine.    Rename this file to PXENGNEW.DLL.

3. Again using the File Manager, locate the file PXENGOLD.DLL in the same directory.    Note the time 
on this file is 02:00:00am, indicating version 2.0 of the Paradox Engine.    Rename this file to 
PXENGWIN.DLL.

4. Make sure you do not have any other copies of PXENGWIN.DLL in other directories, especially in 
your Windows directory (usually C:\WINDOWS).    These would have been installed by other 
products.    If you find any, make sure they are the same version as what you require by reviewing the 
time on the file.    The Windows File Manager search function, located under the File menu, can be 
used to find all copies of this program.      



5. Reconfigure the Paradox Engine.    You will need to set the "Network Type" to the correct value.    
Using the Windows File    Manager, locate the program PXCFGOLD.EXE in the main program 
directory, usually C:\MELSOFT\BILLS.    Run this program by double clicking on it, or selecting "Run" 
from the File menu.    The Paradox Engine Configuration Utility window will appear.    Use the Network 
Configuration button and select the appropriate network type you are using, like Novell NetWare or 
Banyan.    If you are not using a network, select "Not on a network or Other".    Press "OK" to return to 
the Paradox Engine Configuration Utility window.    Then press the "Save" button to save your 
changes.      
                                    

6. Using the Windows File    Manager, delete all The Bill Drawer data files in the data directory (usually 
C:\MELSOFT\BILLS\DATA).    These are all the files with "0200" in the file name, like CAT0200 and 
VEN0200, and extensions like ".DB", ".PX",    ".Xnn" and ".Ynn".      Do not delete any files with an 
extension of ".BAK".    They probably are not in the data directory anyway, but we are just making 
sure.                
        

7. Add the master password to the MAP0200.INI file.    Use the Windows Notepad and add the 
Password=560508 parameter.    See Configuring the Program above, for further details.

8. Start the Bill Drawer again.    Note that you will get messages like "Security file not found in current 
directory - OK    to create new file?".    Respond "OK " and allow the program to create the new files.    
You should get eight of these messages.    

9. After creating the files, Press "OK" on the main The Bill Drawer window and the User Security 
Information window will appear.    Since we deleted the security file, we need to add a new user before
we can restore the files.    Add any user you desire, just make sure that "Can Access" and "Can 
Update" functions are selected for the "User Security Information".    This gives you the ability to 
restore the files.    Exit the program, but do not backup any files.   

10. Remove the master password parameter from the MAP0200.INI file.    Again, use the Windows 
Notepad to remove the PASSWORD=560508 parameter.

11. Start the Bill Drawer again.    This time you should not get any file not found messages and you 
should be able to sign-on as the user you just created.    After signing on, return to the main The Bill 
Drawer window, then restore your original data files using the Restore All Files menu option.    Note 
that you will get messages like "Category file will be restored from CAT0200.BAK - Any current file will
be deleted - OK to restore this file?".    Respond "OK"    and allow the program to restore the files.    
You should get eight of these messages.    

12. After restoring the files, you can sign on normally and use the program.    Your files are now in 
Paradox 3.5 format.

        
Configuring the Paradox Engine:
The Bill Drawer installation program will configure the Paradox Engine for most normal use.    The 
Paradox Engine is a file driver that creates Paradox format files.    It requires entries in your WIN.INI file to
control how it operates.    If you    use a third party product that also uses the Paradox Engine,    you might 
need to increase the resource limits associated with the engine, especially if you plan on running that 
program simultaneously with The Bill Drawer.    

The Bill Drawer installation program will try to detect if the Paradox Engine is already installed by another 
product and warn you that the resource limits may need to be changed.    You should also make sure you 
do not have any other copies of PXENGWIN.DLL in other directories, especially in your Windows 



directory (usually C:\WINDOWS).    These would have been installed by other products.    If you find any, 
make sure they are the same version as what you are using with The Bill Drawer, by reviewing the date 
and time on the file.    The Windows File Manager search function, located under the File menu, can be 
used to find all copies of this program.    If they are different, you can change the Bill Drawer to use the 
older version (see Changing Paradox Versions above), or you can contact technical support for the other 
product and try to get an updated version of the product compatible with Paradox 4.0.                
      
To configure the Paradox Engine, follow these steps:

1. Using the Windows File    Manager, locate the file PXCFGNEW.EXE in the main program directory, 
usually C:\MELSOFT\BILLS.    Run this program by double clicking on it, or selecting "Run" from the 
File menu.    Run the program PXCFGOLD.EXE if you changed to version 2.0 of the Paradox Engine 
(3.5 format files).

2. The Paradox Engine Configuration Utility window will appear.    Use the "Resource Limits" button and 
enter the appropriate values based on your needs.    Press the "OK" to return to the Paradox Engine 
Configuration Utility window, then press the "Save" button to save your changes to the WIN.INI file.

These are the minimum Paradox Engine resource requirements for The Bill Drawer.    Add your 
requirements to these minimums:

· Open Tables - A minimum of 20 is required for The Bill Drawer. 

· Record Buffers - A minimum of 40 is required for The Bill Drawer.

· Record Locks - The Bill Drawer requires 2 locks per table.

· Open Files - A minimum of 40 is required for The Bill Drawer.

· Swap Buffer Size - A minimum of 64K is required for The Bill Drawer.    This is the most important 
parameter.    Make sure you increase it significantly (double it) for each new product.

Deleting the Demonstration Files:
After you have finished using the demonstration files to gain familiarity with the program, you will want to 
delete these files so that you can enter your own data.    Follow these steps to delete the demonstration 
files:

1. Using the Windows File Manager, delete the following data files in the data directory (usually C:\
MELSOFT\BILLS\DATA):
The bank account files - BNK0200.DB and BNK0200.PX.
The history files - HST0200.DB, HST0200.PX, HST0200.X06 and HST0200.Y06.
The unpaid bill files - INV0200.DB, INV0200.PX, INV0200.X02 and INV0200.Y02. 
The company files - VEN0200.DB and VEN0200.PX.

2. The check format files, FRM0200.DB and FRM0200.PX should be kept.    They contain the definitions 
for the check forms described in The Bill Drawer User Guide.    You can add your own format 
definitions and delete any you do not want.

3. The report definition files, RPT0200.DB and RPT0200.PX must be kept.    They contain the definitions
and security requirements for the standard reports.    If you delete these files, you will not be able to 



run reports.

4. The user security files, SEC0200.DB and SEC0200.PX must also be kept.    They contain the 
definitions for all users who can use the program.    You can add your own users and delete any you 
do not want.

                  
5. The category files, CAT0200.DB, CAT0200.PX, CAT0200.X07 and CAT0200.Y07 can be kept or 

deleted depending on if you want to enter your own categories from scratch or modify the ones we 
gave you.    If you decide to modify the categories we supplied, you can clear the statistical totals 
using the "Roll Statistical Totals" menu option on the main The Bill Drawer window.    Select the 
"Category Totals" and the "Roll Yearly Totals" option.    Do this twice so both the this year and last year
totals get cleared.      

6. Start the Bill Drawer again.    Note that you will get messages like "Bank account file not found in 
current directory - OK    to create new file?".    Respond "OK " and allow the program to create the new
files.    

7. Don't miss the Getting Started section in the main program help.    It contains a complete 
implementation plan to help you get started.    Just select "Help Index" from the Help menu on any 
window.    Then select "Getting Started" from the list of topics.          

Converting Your Shareware Version Files:
The shareware version of The Bill Drawer (version 2.10 only, not version 1.1x) and this commercial 
version use the same backup format.    After you install the commercial version of The Bill Drawer you 
received by registering, you can convert your shareware files and save their data by    following these 
steps:

1. Start-up the shareware version of The Bill Drawer and backup all your data files using the Backup All 
Files menu option on the main window, or just allow the program to take a full backup upon exiting.

2. Install the commercial version of The Bill Drawer, using the installation program.    You must install to a
different directory than the shareware version, or your backup files will get overwritten.    You don't 
have to install the demonstration files.

3. For the remaining steps, let's assume that you originally installed the shareware version in C:\
MELSOFT\BILLS and installed the commercial version in C:\MELSOFT\NEWBILLS.

4. Using the Windows File    Manager, copy all the shareware backup files from the old backup directory, 
C:\MELSOFT\BILLS\BACKUP to the new backup directory C:\MELSOFT\NEWBILLS\BACKUP.    The 
backup files are all the files with "0200" in the file name, like CAT0200 and VEN0200, and an 
extension of ".BAK".      
    

5. Start-up the commercial version of The Bill Drawer.    Note that because you did not install the 
demonstration files, you will get messages like "Bank account file not found in current directory - OK    
to create new file?".    Respond "OK " and allow the program to create the new files.    

6. Sign-on using the sample user id provided, then return to the main The Bill Drawer window and 
restore your shareware data files using the Restore All Files menu option.    Note that you will get 
messages like "Category file will be restored from CAT0200.BAK - Any current file will be deleted - OK
to restore this file?".    Respond "OK"    and allow the program to restore the files.    You should get 



eight of these messages.

You now have your old shareware data converted to Paradox format.

Trademarks and Copyrights:
· The Bill Drawer is © Copyright 1993 MelissaSoft Systems.      All rights reserved.

· Microsoft, MS-DOS and Windows are either registered trademarks or trademarks of the Microsoft 
Corporation.

· Paradox    is a registered trademark of Borland International, Inc. 

· The Paradox Engine is © Copyright 1985, 1992 Borland International, Inc.

· All other brand or product names are either registered trademarks or trademarks of their respective 
holders.





MelissaSoft Systems Software License Agreement

This document is a legal agreement between you, the "end user", and MelissaSoft Systems, the owner of 
this software program.    By installing this software program (the "SOFTWARE") you are agreeing to 
be bound by the terms of this agreement.

REGISTRATION: Unlicensed copies of the SOFTWARE are fully functional.    Non-licensed users are 
granted a 30 day limited license, for the purpose of evaluating the SOFTWARE relative to their own 
requirements and needs.    At the end of this 30 day period, non-licensed users are required to either 
register the SOFTWARE, or remove it from all computers where it was installed.    The use of unlicensed 
copies of the SOFTWARE, outside this 30 day period, by any person, business, corporation, government,
or any other entity is strictly prohibited.

To register this software, send $30 (US) to the address at the end of this agreement.    Registration 
includes a printed manual, current commercial version of the SOFTWARE, and notification of new 
releases.    When you pay for shareware that you like, you are encouraging us continue developing and 
enhancing this program.    We have many exciting things planned for the future, but they will only happen 
if sufficent users tell us they like this program by registering it.

DISTRIBUTION: Permission is granted to copy and distribute the unlicensed version of the SOFTWARE, 
subject to the following conditions:

1. The SOFTWARE must be copied in it's entirety, including this license information.

2. Only the unlicensed version of the SOFTWARE may be distributed.    The accompanying written 
materials may not be distributed.

3. The SOFTWARE may not be distributed in conjunction with any other product, without specific written
permission from MelissaSoft Systems.

4. Operators of Electronic Bulletin Board Systems may make the SOFTWARE available for downloading
as long as there is not a specific charge to download the SOFTWARE, excluding membership fees, 
registration fees or time dependent charges relative to the use of the bulletin board system itself.

5. Vendors of shareware software, approved by the Association of Shareware Professionals, may freely 
distribute the SOFTWARE as long as any handling fees, duplication fees, or other forms of fees, 
charges or compensation do not exceed 10 dollars (US) when pro-rated to the SOFTWARE itself.    
Other shareware vendors must receive written permission from MelissaSoft Systems before 
distributing the SOFTWARE.

6. Non-profit groups may freely distribute the SOFTWARE to members of that group, as long as any 
handling fees, duplication fees, or other forms of fees, charges or compensation do not exceed 10 
dollars (US) when pro-rated to the SOFTWARE itself.

7. Any other individual, not in the business of distributing software, may freely distribute the 
SOFTWARE, as long as no fee, charge, or other compensation is requested or received.

End users who have received the SOFTWARE from illegitimate sources are encouraged to write us, with 



immunity, to the address at the end of this agreement indicating the source of the SOFTWARE and the 
conditions imposed.    We will reply with the names of legitimate sources to receive the SOFTWARE from. 
Software received from illegitimate sources should be considered at minimum out of date and void of any 
warranty, and possibly virus infected.

GRANT OF LICENSE: MelissaSoft Systems, the SOFTWARE owner, grants registered users the right to 
copy the enclosed SOFTWARE onto a single computer and the right for you and others to use that copy 
of the SOFTWARE on that single computer.

COPYRIGHT: The SOFTWARE is owned by MelissaSoft Systems and is protected by United States 
copyright laws and international treaty provisions.    Therefore, you must treat the SOFTWARE like any 
other copyrighted material (e.g., a book or musical recording) except that you may (a) make copies of the 
SOFTWARE solely for backup or archival purposes, and (b) transfer the SOFTWARE from floppy disks to
hard disks provided that the SOFTWARE is used as specified herein.    You may not copy the written 
materials accompanying the SOFTWARE.

OTHER RESTRICTIONS: You may not lease, rent, or sub-license the SOFTWARE.    You may not 
transfer the SOFTWARE to another user.    You may not reverse engineer, decompile, disassemble or 
create derivative works from the SOFTWARE.    Only unlicensed versions of the SOFTWARE may be 
distributed as shareware.

LIMITED WARRANTY: This warranty is extended only to registered users of the SOFTWARE.    
MelissaSoft Systems warrants that (a) the SOFTWARE will perform substantially in accordance with the 
accompanying written materials and (b) the SOFTWARE is properly recorded on the disk media.    This 
warranty extends for 30 days after your registration of the SOFTWARE.    There is no warranty after the 
expiration of the warranty period.

THERE ARE NO OTHER WARRANTIES.    MELISSASOFT SYSTEMS AND IT'S SUPPLIERS DISCLAIM
ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO 
IMPLIED WARRANTS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH 
REGARD TO THE SOFTWARE, THE ACCOMPANYING WRITTEN MATERIALS, AND ANY 
ACCOMPANYING HARDWARE.    THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  
YOU MAY HAVE OTHERS WHICH VARY FROM STATE TO STATE.

EXCEPT AS STATED HEREIN, IN NO EVENT SHALL MELISSASOFT SYSTEMS OR IT'S SUPPLIERS 
BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING WITHOUT LIMITATION, DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERUPTION, LOSS OF BUSINESS 
INFORMATION, OR ANY PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE 
THIS SOFTWARE, EVEN IF MELISSASOFT SYSTEMS HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.    BECAUSE SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, USE
OF THE SOFTWARE IN THESE STATES IS PROHIBITED.

CUSTOMER REMEDIES: MelissaSoft Systems and it's suppliers entire liability and your exclusive 
remedy shall be, at MelissaSoft System's option, either (a) return of the registration fees paid, excluding 
any distribution and handling fees, or (b) repair or replacement of the SOFTWARE that does not meet 
MelissaSoft System's Limited Warranty.    This Limited Warranty is void if failure of the SOFTWARE has 
resulted from accident, abuse, or misapplication.
Any replacement SOFTWARE will be warranted for the remainder of the warranty period or 30 days, 
whichever is longer.    In no event shall any liability exceed the registration fees paid.



This Agreement is governed by the laws of the State of California.    Should you have any questions about
this agreement, or you desire to contact MelissaSoft Systems for any reason, please write:

MelissaSoft Systems
11676 Windcrest Lane
San Diego CA 92128.
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